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1 Overview

1.1 Introducing AllNetic Working Time Tracker

AllNetic Working Time Tracker is a handy tool to monitor and keep books of your
working time. AllNetic Working Time Tracker will help you to break down your job into
projects and tasks in order to facilitate your time tracking. Now you will know exactly
how your time is spent. Integrated invoicing feature makes AllNetic Working Time
Tracker indispensable for hourly-paid workers.

AllNetic Working Time Tracker uses minimum of your desktop space (in the system
tray, beside the clock) to signal on time when you need to start or stop your time
tracking.

You decide – not your PC – what you are working on at each moment and are you
working at all. Your PC is made to help you, not to make decisions for you. This is the
main principle of AllNetic Working Time Tracker that will help you in all possible ways.

Main features of AllNetic Working Time Tracker are –

· Unlimited number of projects, tasks and child subtasks.
· Each task supports a separate time counter. You can also check the total time for

each task or project.
· The current status is displayed in the system tray.
· Fast access to the main application features (start/stop, task switching).
· Automatic monitoring for starting and stopping your job.
· Current status and customizable statistics in a pop-up window of the system tray.
· Paid time accounting. In a payable task, a time period may be marked as payable.

This allows determining how much time have you worked for each of your
customers, and how much unpaid time is left.

· Automatic daily backup.
· Multilingual interface.

Who may need AllNetic Working Time Tracker –
· Anybody who wants to know why his/her time disappears
· Programmers
· Lawyers
· Support service
· Administrators
· Managers – for their subordinates' time tracking
· Bank officers
· ...

AllNetic Working Time Tracker may be run on any PC with Windows
2000/XP/2003/2008/Vista/7.



7Overview

© Copyright 1999-2011 AllNetic

1.2 How to buy

You can evaluate AllNetic Working Time Tracker for 30 days. After that you must
either purchase a license or stop using the software.

Upon registering AllNetic Working Time Tracker you get -
· full functional version of the application;
· free technical support;
· e-mail notifications about version update;
· one year of FREE updates;
· significant discounts in future;

Upon registering, you will receive the full functional version and login info for
accessing the special pages on our site, that are only for registered users. No
software is physically sent because the latest version is always available for download
on the Internet.

You can purchase AllNetic Working Time Tracker via Internet from our distributors
with any major credit card, check or wire-transfer. The ordering page is located on a
secure server, ensuring that your confidential information remains confidential. As
soon as we are notified that your order has been processed (usually in one business
day), we will send you all necessary information.

You can purchase AllNetic Working Time Tracker using -

http://www.allnetic.com/howtobuy.html

1.3 Feedback

Visit our official website: http://www.allnetic.com/

If you have already purchased licenses for our product(s), please e-mail to 

http://www.allnetic.com/howtobuy.html?utm_source=allnetic&utm_medium=help_file&utm_campaign=awtt
http://www.allnetic.com/?utm_source=allnetic&utm_medium=help_file&utm_campaign=awtt
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support@allnetic.com. We respond at once to all questions submitted to this e-mail
address in the order they are received.

If you have any purchasing questions, please contact our Sales Department: 

sales@allnetic.com

On other questions, please e-mail to: info@allnetic.com

mailto:support@allnetic.com
mailto:sales@allnetic.com
mailto:info@allnetic.com
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2 How to use

2.1 Getting started

The main application feature is time metering based on multiple tasks. Create
projects you are working on; then in each project create tasks it is divided to. Your
time will be accounted separately for each task, and you will be able to check how
much time you spend on each task or the project as a whole.

1. Run AllNetic Working Time Tracker:

Application main window –
1. Main menu
2. Toolbar
3. Projects list
4. Task list
5. Time periods list
6. Open filtering panel

2. Add projects you are going to monitor.

42
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3. Now for each project create a list of tasks that you want to track separately. 

Please note that you cannot start time tracking for an empty project (containing no
tasks). To start time tracking, create at least one task.

4. That's it! Quick start is done. Now, when you start working, choose appropriate
task and launch time metering . When you finish, stop the metering . AllNetic13 15
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Working Time Tracker will help  you to keep these operations in mind.

5. And the main thing – you decide what are you working on and are you working at
all – not the program. However, feel free to monitor how much time you play video
games... You can track not only your working time, but also you can meter how much
time you fritter away!

2.2 Time Tracking

2.2.1 Time tracking overview

Time tracking is done separately for each task. You choose a task you are working on
and switch on the time tracking. The tracking status is displayed in the system tray:

- time tracking stopped:

- time tracking running:

Put your mouse cursor over the icon to see the pop-up statistics:

Advanced pop-up statistics.
1. Stats
2. Task selected in the main window

20
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3. Previous selected task
4. Edit line for the period description
5. Start button for time tracking of the task selected in the main window
6. Stop button
7. Continue last task button
8. AllNetic Working Time Tracker icon

2.2.2 Start time tracking

Choose a task you are working on and start the time tracking. To start time tracking,

- click on the tray icon (default action on click may be changed in the
application settings )

- or click on the toolbar button

- or choose the main menu Periods -> Start

- or use the tray popup menu

22
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Also you can start tracking without choosing a task. It is possible using the tray
popup menu:

- using list of the last tasks

- using list of all projects and tasks
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2.2.3 Stop time tracking

Stopping time tracking is easily done by –

- clicking on the tray icon (default action on click may be changed in the
application settings )

- or clicking on the toolbar button

- or choosing the main menu Periods -> Start

22
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- or using the tray popup menu

2.2.4 Continue last task

If you pause your job for some time and stop the time tracking, you can then restart
tracking your last task. In this case the time period description will be the same as
the previous one. To restart last task tracking,

- Shift + click on the tray icon  (default action on click may be changed in
the application settings )

- or click on the toolbar button

22
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- or choose the main menu Periods -> Start

- or use tray popup menu
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2.2.5 Switching between tasks

When you work on a project, you often switch between several tasks. There are
several ways to do so. The longest way is to restore the main application window,
stop time tracking, select another task, and then start tracking. In order to switch fast
between tasks, use the following operations.

· Recent tasks list in tray popup menu
· Full projects list in tray popup menu

2.2.6 Payable tasks

AllNetic Working Time Tracker provides you with special features to track payed
projects and tasks. At any time you can check how much time is still unpaid. Payable
tasks that contain unpaid periods may be displayed in a different manner:

1. Normal or fully paid task
2. Payable task that was not fully paid.
3. Paid period
4. Unpaid period

You can set if a project or task is payable using the popup menu of this project or
task –

50

51
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or via task properties .

In a same way you set if a period was paid. Select paid periods and use the popup
menu –

44
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– to set the paid attribute. Also you can set it individually for each period via editing
its properties .

2.3 Automatic start/stop intelligence

2.3.1 Automatic start/stop intelligence

Sometimes you are distracted from job 'just for a minute' that turns to hours, or on
the other hand, sometimes you dive into work but forget to switch on the time
tracking.

Automatic tracking intelligence will remind you mildly about that. A small popup
window in the bottom left of your screen will remind you about something that you
probably have forgotten.

We did our best to make the reminders the most mild and simple:
· the reminder window pops up in the corner of your screen (you can drag it to any

[place you want, and next time it will appear there)
· by clicking on Cancel, you abandon both proposal to start or stop time tracking, i.

e. you ignore the proposed action.
· normally you can click on Ok to accept the action without any changes.

46
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2.3.2 Automatic start

Automatic start is proposed if –
· this feature is on in the application settings
· time tracking was stopped
· during some time there is no activity on the PC (no keys pressed, no mouse

movement, etc = 'the user has left')
· if there is some activity again, the program will check if it is a working activity or

just a caretaker has pushed you table with his trolley and moved the mouse.

2.3.3 Automatic stop

Automatic stop is proposed if –
· this feature is on in the application settings
· time tracking was started
· during some time there is no activity on the PC (no keys pressed, no mouse

movement, etc = 'the user has left')

22

22
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2.4 Customize application

2.4.1 Customize application

AllNetic Working Time Tracker offers you a variety of features that are customizable
to your needs. To bring up the customization dialog, use menu Options -> Application
Options:

For detailed description of options see Application Settings .54
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2.5 Reports

2.5.1 Creating reports

Thanks to the unique MLGen technology, AllNetic Working Time Tracker provides with
multifunctional tools for creating reports based on any selected data, exporting data
to other applications, printing, etc.

Several report templates are shipped along with AllNetic Working Time Tracker to
create reports in HTML, CSV, TXT and XML format.

MLGen separates data from presentation and lets you and your users change the
format of the output text without rebuilding the application or changing the data
source. MLGen takes some template (regular string with XML-like tags) as input and
produces some output. 
 
With MLGen producing text in different formats is easy as ABC -- you specify the
template and let your application supply data to the generator. The rest is defined by
template. Whenever you need a plain text, XML or HTML, SGML, CSV or custom text
document, you get any of them by just changing one property of the component. 
 
Processing of template is affected by set of properties and events set by the
application. The application passes the data to the generator on request, i.e. when
MLGen comes across <macro> tag. Several tags let you implement loops and

conditions and comment some parts of template. The information represented as
plain text in template is passed to output without changes (with except of tag
processing which might cause repetition or exclusion of information). 
 
When needed you can add custom tags and even add scripting to your template, thus
letting your users write powerful data processing routines directly in template. 
 
You can edit existing templates or create new ones using a simple template language

.27
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2.5.2 Example reports

2.5.2.1 Example HTML report

2.5.2.2 Example text report

--------
Summary:

  First date : Friday, June 06, 2003, 07:06:36 AM
  Last date  : Monday, June 09, 2003, 08:09:53 PM
  Total time : 34:06:59

---------
Detailed:

  1. Project: Project 1
      Time: 28:44:28
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      1.1. Task: 'Task 0'. Time: 26:30:01

          Periods:
          08:03:36, from 6/8/2003, 11:00:17 AM to 6/8/2003, 07:03:53 PM
          06:04:59, from 6/7/2003, 01:00:00 PM to 6/7/2003, 07:04:59 PM
          11:53:24, from 6/6/2003, 07:06:36 AM to 6/6/2003, 07:00:00 PM
          00:06:58, from 6/9/2003, 08:02:55 PM to 6/9/2003, 08:09:53 PM
          00:12:47, from 6/9/2003, 10:06:04 AM to 6/9/2003, 10:18:51 AM
          00:01:15, from 6/9/2003, 11:04:15 AM to 6/9/2003, 11:05:30 AM
          00:07:02, from 6/9/2003, 02:11:10 PM to 6/9/2003, 02:18:12 PM
      1.2. Task: 'Task 1'. Time: 02:14:27

          Periods:
          02:14:27, from 6/9/2003, 09:30:55 AM to 6/9/2003, 11:45:22 AM
                
  2. Project: Project 0
      Time: 02:11:48

      2.1. Task: 'Task 1'. Time: 00:35:43

          Periods:
          00:08:15, from 6/9/2003, 01:00:15 PM to 6/9/2003, 01:08:30 PM
          00:27:28, from 6/8/2003, 02:05:51 PM to 6/8/2003, 02:33:19 PM
      2.2. Task: 'Task 2'. Time: 01:36:05

          Periods:
          00:10:24, from 6/9/2003, 04:54:24 PM to 6/9/2003, 05:04:48 PM
          01:25:41, from 6/9/2003, 05:06:24 PM to 6/9/2003, 06:32:05 PM
                
  3. Project: Project 2
      Time: 03:10:43

      3.1. Task: 'Task 0'. Time: 03:10:43

          Periods:
          03:10:43, from 6/9/2003, 07:15:22 AM to 6/9/2003, 10:26:05 AM
-----------------------------------------------------------------------

2.5.2.3 Example CSV report

"Project name","Task name","Time","Begin time","End time"
"","","34:06:59","6/6/2003, 07:06:36 AM","6/9/2003, 08:09:53 PM"
"Project 1","","28:44:28","6/6/2003, 07:06:36 AM","6/9/2003, 08:09:53 PM"
"Project 1","'Task 0'","26:30:01","6/6/2003, 07:06:36 AM","6/9/2003, 08:09:53 PM"
"Project 1","'Task 0'","08:03:36","6/8/2003, 11:00:17 AM","6/8/2003, 07:03:53 PM"
"Project 1","'Task 0'","06:04:59","6/7/2003, 01:00:00 PM","6/7/2003, 07:04:59 PM"
"Project 1","'Task 0'","11:53:24","6/6/2003, 07:06:36 AM","6/6/2003, 07:00:00 PM"
"Project 1","'Task 0'","00:06:58","6/9/2003, 08:02:55 PM","6/9/2003, 08:09:53 PM"
"Project 1","'Task 0'","00:12:47","6/9/2003, 10:06:04 AM","6/9/2003, 10:18:51 AM"
"Project 1","'Task 0'","00:01:15","6/9/2003, 11:04:15 AM","6/9/2003, 11:05:30 AM"
"Project 1","'Task 0'","00:07:02","6/9/2003, 02:11:10 PM","6/9/2003, 02:18:12 PM"
"Project 1","'Task 1'","02:14:27","6/9/2003, 09:30:55 AM","6/9/2003, 11:45:22 AM"
"Project 1","'Task 1'","02:14:27","6/9/2003, 09:30:55 AM","6/9/2003, 11:45:22 AM"
"Project 0","","02:11:48","6/8/2003, 02:05:51 PM","6/9/2003, 08:02:54 PM"
"Project 0","'Task 1'","00:35:43","6/8/2003, 02:05:51 PM","6/9/2003, 01:08:30 PM"
"Project 0","'Task 1'","00:08:15","6/9/2003, 01:00:15 PM","6/9/2003, 01:08:30 PM"
"Project 0","'Task 1'","00:27:28","6/8/2003, 02:05:51 PM","6/8/2003, 02:33:19 PM"
"Project 0","'Task 2'","01:36:05","6/9/2003, 04:54:24 PM","6/9/2003, 08:02:54 PM"
"Project 0","'Task 2'","00:10:24","6/9/2003, 04:54:24 PM","6/9/2003, 05:04:48 PM"
"Project 0","'Task 2'","01:25:41","6/9/2003, 05:06:24 PM","6/9/2003, 06:32:05 PM"
"Project 2","","03:10:43","6/9/2003, 07:15:22 AM","6/9/2003, 10:26:05 AM"
"Project 2","'Task 0'","03:10:43","6/9/2003, 07:15:22 AM","6/9/2003, 10:26:05 AM"
"Project 2","'Task 0'","03:10:43","6/9/2003, 07:15:22 AM","6/9/2003, 10:26:05 AM"

2.5.2.4 Example XML report

<?xml version="1.0" encoding="windows-1252"?>
<schedule title='' start='Friday, June 06, 2003, 07:06:36 AM' finish='Monday, June 09,
2003, 08:09:53 PM' timelength='34:06:59'>

<projects>
<project number='1' name='Project 1' start='6/6/2003, 07:06:36 AM' finish='6/9/2003,
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08:09:53 PM' timelength='28:44:28'>
<tasks>
<task number='1' name='Task 0' start='6/6/2003, 07:06:36 AM' finish='6/9/2003,

08:09:53 PM' timelength='26:30:01'>
<periods>

<period start='6/8/2003, 11:00:17 AM' finish='6/8/2003, 07:03:53 PM'
timelength='08:03:36'/>

<period start='6/7/2003, 01:00:00 PM' finish='6/7/2003, 07:04:59 PM'
timelength='06:04:59'/>

<period start='6/6/2003, 07:06:36 AM' finish='6/6/2003, 07:00:00 PM'
timelength='11:53:24'/>

<period start='6/9/2003, 08:02:55 PM' finish='6/9/2003, 08:09:53 PM'
timelength='00:06:58'/>

<period start='6/9/2003, 10:06:04 AM' finish='6/9/2003, 10:18:51 AM'
timelength='00:12:47'/>

<period start='6/9/2003, 11:04:15 AM' finish='6/9/2003, 11:05:30 AM'
timelength='00:01:15'/>

<period start='6/9/2003, 02:11:10 PM' finish='6/9/2003, 02:18:12 PM'
timelength='00:07:02'/>

</periods>
</task>
<task number='2' name='Task 1' start='6/9/2003, 09:30:55 AM' finish='6/9/2003,

11:45:22 AM' timelength='02:14:27'>
<periods>

<period start='6/9/2003, 09:30:55 AM' finish='6/9/2003, 11:45:22 AM'
timelength='02:14:27'/>

</periods>
</task>

</tasks>
</project>
<project number='2' name='Project 0' start='6/8/2003, 02:05:51 PM' finish='6/9/2003,

08:02:54 PM' timelength='02:11:48'>
<tasks>
<task number='1' name='Task 1' start='6/8/2003, 02:05:51 PM' finish='6/9/2003,

01:08:30 PM' timelength='00:35:43'>
<periods>

<period start='6/9/2003, 01:00:15 PM' finish='6/9/2003, 01:08:30 PM'
timelength='00:08:15'/>

<period start='6/8/2003, 02:05:51 PM' finish='6/8/2003, 02:33:19 PM'
timelength='00:27:28'/>

</periods>
</task>
<task number='2' name='Task 2' start='6/9/2003, 04:54:24 PM' finish='6/9/2003,

08:02:54 PM' timelength='01:36:05'>
<periods>

<period start='6/9/2003, 04:54:24 PM' finish='6/9/2003, 05:04:48 PM'
timelength='00:10:24'/>

<period start='6/9/2003, 05:06:24 PM' finish='6/9/2003, 06:32:05 PM'
timelength='01:25:41'/>

</periods>
</task>

</tasks>
</project>
<project number='3' name='Project 2' start='6/9/2003, 07:15:22 AM' finish='6/9/2003,

10:26:05 AM' timelength='03:10:43'>
<tasks>
<task number='1' name='Task 0' start='6/9/2003, 07:15:22 AM' finish='6/9/2003,

10:26:05 AM' timelength='03:10:43'>
<periods>

<period start='6/9/2003, 07:15:22 AM' finish='6/9/2003, 10:26:05 AM'
timelength='03:10:43'/>

</periods>
</task>

</tasks>
</project>

</projects>
</schedule>
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2.5.3 Template language

2.5.3.1 Template language overview

Each template is a string that contains zero or more text characters and zero or more
control tags. Tag is a case-sensitive character sequence that is enclosed in < and >
characters. Each tag has a name - alphanumeric sequence of characters. Optionally
the tag name can be prefixed by TagPrefix, that is specified as a property. 
 
Each tag can have one or more parameters represented as name="value" pair. Each
tag must either be closed or have a closing pair. 
 
Example:
 

<#macro name="MacroName"/>
 
<#if name="condition"><#/if name="condition">

 
Unlike XML and HTML languages, each control tag including closing tags must have
non-empty "name" parameter as shown in the above example for if tag.
 
Each tag can have any number of optional parameters. 
 
The following tags are defined:
· Loops
· Conditions
· Macros
· Comments
· Parameters

2.5.3.2 Translation tables

Translation tables are used to convert the data provided by the application to the
format that will not conflict with specification. Usually the application returns the data
as-is. However what if template requires some characters to be escaped or encoded?
 
Example: the application will return multiple lines of data delimited with CRLF.
However in HTML document such formatting must be changed to <br> tag.
Translation tables are designed to convert results of macro substitutions
automatically. This way when new template with new formatting is added, the
application doesn't have to be modified - template will do the job itself.
 
Translation table is included to template inside <params> tag as follows:

<#params>
 
  <#translation name="Translation_Table_Name"
default="True">
 
    <#replace string="string1" with="string2"/>
 
    <#replace string="string1">string2<#/replace>
 

28
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    <#replace string="string1" with="stri">ng2<#/replace>
 
  <#/translation name="Translation_Table_Name">
 
<#/params>

Table consists of one or more replace tags with parameters. Each replace tag specifies
a sequence of characters to be replaced and a sequence of characters to be used as a
replacement.

There can be more than one translation table in the template. In this case all tables
must have different names and "default" parameter for exactly one table must be set
to true.

2.5.3.3 Control Tags

2.5.3.3.1  Loops

Syntax:
 

<#repeat name="loop name"><#/repeat name="loop name">

Loops represent Pascal/C while loop and  let the application process the block zero or
more times depending on application-defined condition.

Available names of task based loops:

· name="Projects"
Loop on all projects.
Parameters:

sort="Alphabetical|Duration|BeginDateTime|NoSort" // default =
Alphabetical

descend="True|False" // default = False

· name="Tasks"
Loop on all tasks.
Parameters:

sort="Alphabetical|Duration|BeginDateTime|NoSort" // default =
Alphabetical

descend="True|False" // default = False

· name="Periods"
Loop on all periods.
Parameters:

sort="Ascend|Descend|NoSort" // default = Ascend

Available names of time based loops:

· name="Month"
Loop on all months.
Parameters:
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sort="Ascend|Descend" // default = Ascend

· name="Week"
Loop on all weeks.
Parameters:

sort="Ascend|Descend" // default = Ascend

· name="Day"
Loop on all days.
Parameters:

sort="Ascend|Descend" // default = Ascend

· name="TimePeriods"
Loop on all periods.
Parameters:

sort="Ascend|Descend|NoSort" // default = Ascend

For example:

<#repeat name="Projects" sort="Alphabetical">
...

<#/repeat name="Projects">

2.5.3.3.2  Conditions

Syntax:
 

<#if name="condition name"><#else name="condition
name"/><#/if name="condition name">

Conditions let the application put one of two parts of template to output document.
Blocks enclosed in <if> tag are not limited to plain text and can contain other control

tags. 
 
Available names of conditions:

· name="PageNumber"
The condition is TRUE if the current page number is equal to the specified value.
Parameters:

value="XX" // XX is a number or "last"
offset="XX" // XX - positive or negative offset added to the current page

number

· name="ProjectCount"
This condition compares the number to the specified value.
Parameters:

condition="Greater|Less|Equality"
value="XX" // XX = Number
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· name="DetailedProjects"
The condition is TRUE if the user has selected detailed projects. 

Conditions operational in Projects loop  only:

· name="TaskCount"
This condition compares the number to the specified value.
Parameters:

condition="Greater|Less|Equality"
value="XX" // XX = Number

· name="ProjectNumber"
The condition is TRUE if the current project number is equal to the specified value.
Parameters:

value="XX" // XX = Number

offset="XX" // XX - positive or the negative offset added to current project

number

· name="ProjectDescExist"
The condition is TRUE if the current project description exists

· name="ProjectHidden"
The condition is TRUE if the current project is hidden

· name="ProjectPayable"
The condition is TRUE if the current project is payable

· name="DetailedTasks"
The condition is TRUE if the user has selected detailed tasks. 

Conditions operational in Tasks loop  only:

· name="PeriodCount"
This condition compares the number to the specified value.
Parameters:

condition="Greater|Less|Equality"
value="XX" // XX = Number

· name="TaskNumber"
The condition is TRUE if the current task number is equal to the specified value.
Parameters:

value="XX" // XX = Number

offset="XX" // XX - positive or the negative offset added to current task

number

· name="TaskDescExist"
The condition is TRUE if the current task description exists.

· name="TaskHidden"
The condition is TRUE if the current task is hidden

28
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· name="TaskTrackOnly"
The condition is TRUE if the current task is marked as "Track Only"

· name="TaskPayable"
The condition is TRUE if the current task is payable

· name="DetailedPeriods"
The condition is TRUE if the user has selected detailed periods. 

Conditions operational in Periods loop  only:

· name="PeriodNumber"
The condition is TRUE if the current period number is equal to the specified value.
Parameters:

value="XX" // XX = Number

offset="XX" // XX - positive or the negative offset added to current period

number

· name="PeriodPaidUp"
The condition is TRUE if the current period was paid.

· name="PeriodDescExist"
The condition is TRUE if the current period description exists.

For example:

<#if name="ProjectDescExist">
...
<#/if name="ProjectDescExist">

<#if name="DetailedPeriods">
...
<#else name="DetailedPeriods"/>
...
<#/if name="DetailedPeriods">

2.5.3.3.3  Macros

Syntax:
 

<#macro name="macro name"/>

Macros let the application substitute some information in the place of macro.

Parameters of any macro:
length="0..x" // minimum length (default 0)

alignment="Left|Right|Center" // text alignment (default Left)

28
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Parameters of any date and time macro:
datetype="Long|Short|Custom" // default Short
showdate="True|False" // default True. Used only if datetype

<> "Custom".
showtime="True|False" // default True. Used only if datetype

<> "Custom".
showseconds="True|False" // defaults to application

settings. Used only if datetype <> "Custom".
format="XX" // Used only if datetype = "Custom". XX -

Date/Time format strings  control the formatting of dates and
times.

Available names of macros:

· name="UserName"
Inserts a name of the current user.

· name="TotalFirstDateTime"
The beginning of the report interval.

· name="TotalLastDateTime"
The end of the report interval.

· name="TotalTimeLength"
Length of the report interval (in hours, minutes, seconds).
Parameters:

mode="Full|HideSeconds|DecimalsOfHour|RoundUp5Min|RoundUp10Min|Ro
undUp15Min|RoundUp20Min|RoundUp30Min|RoundUpHour"

· name="TotalProjects"
Total of projects in the report.

· name="PageCount"
Total of pages of the report.

· name="PageNumber"
Page number. It is possible to get the number of the previous page by specifying 
offset="-1" or the following page by specifying offset="1". The returned

number will always be between 1 and PageCount.
Parameters:

offset="XX" // XX - positive or the negative offset added to current page

number.

· name="FileName"
The filename the report is saved to.
By specifying the offset parameter, it is possible to get the name of the following or
previous page.
Parameters:

offset="XX" // XX - positive or the negative offset added to the current page

number.

35
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Macros operational in Projects loop  only:

· name="ProjectUID"
Unique identifier of the current project.

· name="ProjectNumber"
Serial number of the current project.

· name="ProjectName"
Name of the current project.

· name="ProjectDesc"
The description of the current project.

· name="ProjectFirstDateTime"
The beginning of the report interval.

· name="ProjectLastDateTime"
The end of the report interval.

· name="ProjectTimeLength"
Length of the interval (in hours, minutes, seconds) of the report.
Parameters:

mode="Full|HideSeconds|DecimalsOfHour|RoundUp5Min|RoundUp10Min|Ro
undUp15Min|RoundUp20Min|RoundUp30Min|RoundUpHour"

· name="ProjectDuration"
Project duration (in seconds).

Macros operational in Tasks loop  only:

· name="TaskUID"
Unique identifier of the current task.

· name="TaskOwnerUID"
Unique identifier of the parent of the current task.

· name="TaskNumber"
Serial number of the current task.

· name="TaskName"
Name of the current task.
Parameters:

type="Short|FullTask|FullProject" // default FullTask

· name="TaskDesc"
The description of the current task.

· name="TaskFirstDateTime"
The beginning of the task interval.
Parameters:

28
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inclchild="True|False" // default = TRUE

· name="TaskLastDateTime"
The end of the task interval.
Parameters:

inclchild="True|False" // default = TRUE

· name="TaskTimeLength"
Length of the task interval (in hours, minutes, seconds).
Parameters:

mode="Full|HideSeconds|DecimalsOfHour|RoundUp5Min|RoundUp10Min|Ro
undUp15Min|RoundUp20Min|RoundUp30Min|RoundUpHour"

inclchild="True|False" // default = TRUE

· name="TaskDuration"
Task duration (in seconds).

Macros operational in Periods loop  only:

· name="PeriodUID"
Unique identifier of the current period.

· name="PeriodNumber"
Serial number of the current period.

· name="PeriodDesc"
The description of the current period.

· name="PeriodBeginDateTime"
The beginning of the period interval.

· name="PeriodEndDateTime"
The end of the period interval.

· name="PeriodLength"
Period length (in hours, minutes, seconds).
Parameters:

showseconds="True|False" // defaults to application settings

· name="PeriodDuration"
Period duration (in seconds).

Macros operational in time based loops  only:

· name="LoopBeginDateTime"
The beginning of the current loop interval.

· name="LoopEndDateTime"
The end of the current loop interval.

28
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For example:

<#macro name="PeriodLength" length="20"
alignment="Center"/>

2.5.3.3.3.1  Date/Time format strings

Date-Time Format Strings specify the formatting of date-time values when they are
converted to strings. Date-Time Format Strings are passed to formatting routines,
and are also used to set certain global variables.

Date Time Format Strings are composed from specifiers that represent values to be
inserted into the formatted string. Some specifiers (such as "d"), simply format
numbers or strings. Other specifiers (such as "/") refer to locale-specific strings from
global variables.

In the following table, specifiers are given in lower case. Case is ignored in formats,
except for the "am/pm" and "a/p" specifiers.

Specifier Displays
c Displays the date using the format given by the ShortDateFormat global

variable, followed by the time using the format given by the
LongTimeFormat global variable. The time is not displayed if the
date-time value indicates midnight precisely.

d Displays the day as a number without a leading zero (1-31).
dd Displays the day as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by

the ShortDayNames global variable.
dddd Displays the day as a full name (Sunday-Saturday) using the strings

given by the LongDayNames global variable.
ddddd Displays the date using the format given by the ShortDateFormat global

variable.
dddddd Displays the date using the format given by the LongDateFormat global

variable.
e (Windows only) Displays the year in the current period/era as a number

without a leading zero (Japanese, Korean and Taiwanese locales only).
ee (Windows only) Displays the year in the current period/era as a number

with a leading zero (Japanese, Korean and Taiwanese locales only).
g (Windows only) Displays the period/era as an abbreviation (Japanese and

Taiwanese locales only).
gg (Windows only) Displays the period/era as a full name. (Japanese and

Taiwanese locales only).
m Displays the month as a number without a leading zero (1-12). If the m

specifier immediately follows an h or hh specifier, the minute rather than
the month is displayed.

mm Displays the month as a number with a leading zero (01-12). If the mm
specifier immediately follows an h or hh specifier, the minute rather than
the month is displayed.

mmm Displays the month as an abbreviation (Jan-Dec) using the strings given
by the ShortMonthNames global variable.
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mmmm Displays the month as a full name (January-December) using the strings
given by the LongMonthNames global variable.

yy Displays the year as a two-digit number (00-99).
yyyy Displays the year as a four-digit number (0000-9999).
h Displays the hour without a leading zero (0-23).
hh Displays the hour with a leading zero (00-23).
n Displays the minute without a leading zero (0-59).
nn Displays the minute with a leading zero (00-59).
s Displays the second without a leading zero (0-59).
ss Displays the second with a leading zero (00-59).
z Displays the millisecond without a leading zero (0-999).
zzz Displays the millisecond with a leading zero (000-999).
t Displays the time using the format given by the ShortTimeFormat global

variable.
tt Displays the time using the format given by the LongTimeFormat global

variable.
am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays

'am' for any hour before noon, and 'pm' for any hour after noon. The
am/pm specifier can use lower, upper, or mixed case, and the result is
displayed accordingly.

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a'
for any hour before noon, and 'p' for any hour after noon. The a/p
specifier can use lower, upper, or mixed case, and the result is displayed
accordingly.

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays
the contents of the TimeAMString global variable for any hour before
noon, and the contents of the TimePMString global variable for any hour
after noon.

/ Displays the date separator character given by the DateSeparator global
variable.

: Displays the time separator character given by the TimeSeparator global
variable.

'xx'/"xx" Characters enclosed in single or double quotes are displayed as-is, and do
not affect formatting.

2.5.3.3.4  Comments

Syntax:
 

<#comment name="name"/>

or

<#comment name="name">...<#/comment name="name">

Comments are not processed and are thrown away. Comments exclude part of
template they wrap from processing. Comments can be nested.

For example:

<#comment name="MyComment" value="This is my comment"/>

<#comment name="MyComment">
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This is my comment
<#/comment name="MyComment">

2.5.3.3.5  Template Parameters

Syntax:
 

<#params>

<#param name="Param_Name" value="ParamValue"/>

<#param name="Param_Name">ParamValue<#/param>

<#param name="Param_Name" value="ParamVa">lue<#/param>

<#translation name="Translation_Table_Name"
default="True">

<#replace string="string1" with="string2"/>

<#replace string="string1">string2<#/replace>

<#replace string="string1"
with="stri">ng2<#/replace>

<#/translation name="Translation_Table_Name">

<#/params>

Parameters let template creator tell something to the application that will produce
some output using template. They are accessible via Parameters property of the
generator. Currently there are only two predefined parameter tags -- 
<translation> and <replace>. They describe translation tables .

 
Parameters that may be used in templates:

· name="Description"
The template description.

· name="Output file type"
File type, e. g. "HTML", "Text", "CSV", "XML", "Printable HTML"

· name="Default output file name"
Default output filename (no extension).

· name="Output file extension"
Output filename extension.

· name="Can show projects detail"
The template supports detailed projects.

value="True|False"

27
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· name="Can show tasks detail"
The template supports detailed tasks.

value="True|False"

· name="Can show periods detail"
The template supports detailed periods.

value="True|False"

Also you can add any other parameters, for instance, the author of the template.

For example:

<#params>
<#param name="Description" value="HTML report"/>
<#param name="Output file type" value="HTML"/>
<#param name="Default output file name"

value="Report.html"/>
<#param name="Output file extension" value=".html"/>
<#param name="Can show projects detail" value="True"/>
<#param name="Can show tasks detail" value="True"/>
<#param name="Can show periods detail" value="True"/>

<#translation name="HTML_Translation_Table"
default="Macro">

<#replace string="#22" with="&quot;"/>
<#replace string="<" with="&lt;"/>
<#replace string=">" with="&gt;"/>
<#replace string="&" with="&amp;"/>

<#/translation name="HTML_Translation_Table">
<#/params>

2.6 Invoice

2.6.1 Creating invoices

Invoicing is based on reports. For details see creating reports .

Due to the integrated tracking of unpaid time, AllNetic Working Time Tracker will
ensure you always invoice your customers correctly.

2.7 How to print

2.7.1 How to print

The best way to print data from AllNetic Working Time Tracker is to create a report
or an invoice  and to print it using any application you want.

You can create reports using templates in HTML, TXT, CSV or XML. Moreover, you can

23
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edit templates or create your own ones.

2.8 Export

2.8.1 Export

Data export is based on reports. For details see creating reports .

CSV or XML is recommended for data export. Probably it is also better to create your
own template corresponding to your specific needs.

2.9 Import

2.9.1 Import

AllNetic Working Time Tracker can import data in several formats. If you cannot
import data from some format, please contact us , and we will add this functionality
to next version of AllNetic Working Time Tracker.

To import data, choose Import command in the File menu.

In the dialog box, choose CSV file and click on the Next button.

23
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Current version of AllNetic Working Time Tracker is able to import data from –
· CSV files
· Internal data format
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3 Explaining the user interface

3.1 The workspace

3.1.1 The workspace overview

1. Main menu
2. Toolbar
3. Projects list
4. Task list
5. Time periods list
6. Open filtering panel

In any list of the application you can select multiple entries for group operations. To
select multiple elements, hold down Shift or Ctrl.

If several projects are selected, tasks of all selected projects will be displayed.

If several tasks are selected, periods of all selected tasks will be displayed.

Using the filtering panel , you can toggle displaying all periods of all tasks.

3.1.2 Filtering panel

Using the filtering feature, you can hide data that you don't need to be displayed at
the moment.

42
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1. Hide the panel
2. Beginning date and time
3. End date and time
4. Show periods for all tasks
5. Show hidden projects and tasks
6. Show paid and unpaid periods
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3.2 Project and Task properties

3.2.1 Project and Task properties

Right-click on a project or task to edit its properties:

Project options dialog -

  

and Task options dialog -
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1. Name
You can use any name repeatedly.

2. Hide project/task.
Use this to hide tasks that you are not going to use soon. This will help you to
relieve the lists of redundant information. You can display hidden tasks at any
time using Show hidden projects and tasks mode.

3. Payable
Payable task . Check this if you are payed for this project/task.

4. Track only. (for tasks only)
The total task time consists of time spent for the task itself and for all subtasks.
Tasks with Track only option on are not included.

5. Description.
Any notes you wish to add.

Note: Press F2 to rename selected project or task.

18
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3.3 Period properties

3.3.1 Period properties

Right-click on a period to edit its properties:
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1. Period start time
2. Insert current time
3. Period end time

When adding a period, you can abandon setting the end time (uncheck the End
Time). This way you can start a period at any time, not only at current time.
After you can edit the current period starting time.

4. Insert current time
5. Period duration
6. Period paid

This option is only available for periods in payable tasks. Check it on of the
period was paid. 

7. Period description
Any notes you wish to add about this period.

3.4 Tray icon

3.4.1 Tray icon overview

The system tray icon is one of the key software interface elements. Using the tray
icon, you can start or stop time tracking, switch between tasks and get statistics.
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Please mouse cursor over the tray icon to bring up the advanced tray hint . Here
the current status and statistics are displayed.

Right-click the tray icon to display the popup menu , which is convenient to switch
between tasks.

49
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3.4.2 Advanced hint

3.4.2.1 Advanced hint

You can display current status at any time by rolling the mouse over the system tray
icon:

Advanced tray hint
1. Statistics
2. Currently selected task
3. Previous fulfilled task
4. Period description
5. Start time tracking for currently selected task
6. Stop time tracking
7. Continue previous task
8. AllNetic Working Time Tracker icon
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3.4.3 Popup menu

3.4.3.1 Tray popup menu

Using the popup menu, you can bring up the main window (by Restore command),
start of stop time tracking or switch between tasks.

3.4.3.2 Recent list

This list contains recent tasks you were working on. Using the resent tasks list is fast
and convenient way to start or stop time tracking and to switch between tasks.
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3.4.3.3 Full projects list

Using this full list of projects and tasks, you can start time tacking or switch between
tasks without displaying the application main window.

3.5 Automatic Start Dialog

3.5.1 Automatic Start Dialog

When AllNetic Working Time Tracker detects  that use has started his work, it will
propose  to start time tracking.

1. Task selection.
2. Tracking start time (automatically set to the time user activity was detected).

20
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3. Set current time as the tracking start time.
4. Click OK to start time tracking of the currently selected task starting from the
specified time.
5. Click Cancel to abandon time tracking start.

3.6 Automatic Stop Dialog

3.6.1 Automatic Stop Dialog

When AllNetic Working Time Tracker detects  that user has stopped his work, it will
propose  to stop time tracking.

1. Continue time tracking but don't count the time of absence.
2. Stop time tracking and don't count the time of absence.
3. Continue time tracking but count the time of absence as another task.

Additional parameters are possible for each of the three commands:

20
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1. The time when work was stopped (automatically set to the time when activity stop
was detected ).
2. Set current time as the tracking stop time.
3. Click OK to stop time tracking at the specified time.
4. Click Cancel to abandon time tracking stop.

This is the default mode. Click OK to stop time tracking at the time the activity stop
was detected, or click Cancel to continue tracking.

1. Time that will be excluded from the tracked time.
2. Set this checkbox on if you want to exclude total absence time.
3. Click OK to continue time tracking excluding the specified time.
4. Click Cancel to abandon.

This mode is suitable when you don't need to count your absence time, e. g. your
coffee break.

1. Time that will be passed to another task.
2. Here you select the task to which the time will be passed.
3. Click OK to continue time tracking of the current task after passing the specified

20
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time to the selected task.
4. Click Cancel to abandon.

This mode is much like previous one except the time of absence will not be
abandoned but passed to another task. For example, this way you can count how
much time you spend for coffee breaks.

3.7 Application Options

3.7.1 Application Options overview

1. Restore default setting for the current tab.
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3.7.2 Main

1. If this option is on, AllNetic Working Time Tracker will start automatically on
Windows start.
2. If this option is on, clicking the Close button in the main window caption will
minimize AllNetic Working Time Tracker. You can still close the application using
menu File -> Exit.
3. If this option is on, AllNetic Working Time Tracker will check the latest version
available on the official web site.
4. Periodicity of automatic check.
5. Check up the latest version now.
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3.7.3 User

1. Enter your name here. This information may be used, for example, for creating
reports and invoices.
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3.7.4 File

1. If this option is on, a backup file (*.bak) will be created on each saving data to file.
2. If this option is on, a backup (*.bak) for each saved file will be created once per
each application launch.
As far as by default data are saved each minute, in case of data loss (e. g. casual
project deletion) it is easier to restore data if this option is on.
3. If this option is on, every day the data file will be packed to ZIP. The archive name
consists of your data filename, a date and the .zip extension.
4. Here you specify how long you want to keep a backup (in days).
5. Automatic backup period. 60 seconds are recommended.
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3.7.5 View

1. Period list grouping:
1.1. Periods grouped by months and days of month.
1.2. Periods grouped by week number and days of months.
1.3. Periods grouped by days of months.

2. If this option is on, periods for all tasks will be displayed in the period list.
Otherwise, periods from selected projects or tasks will be displayed.
3. If this option is on, data from hidden projects and tasks will be displayed.
4. If this option is on, seconds will be abandoned in time display.
5. Period duration display:

5.1. Full. Hours, minutes and seconds, e. g. 123:45:57
5.2. Hide seconds. Hours and minutes, e. g. 123:45
5.3. Decimal. Time in hours with one hundredth resolution, e. g. 123.75 (123

hours 45 minutes).
6. Full task name creation rules:

6.1. Separator before project/task name.
6.2. Separator after project/task name.
6.3. Separator between task names.
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3.7.6 Columns

You can customize columns of project, task and period lists.

List settings:

1. If this option is on, all columns will be shrink to fit current list size.
2. If this option is on, vertical lines will be displayed.

Column settings:
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1. If this option is on, the column will not be displayed.
2. Column width in pixels. This setting will be adapted automatically if shrink to fit
option is on.

3.7.7 Mark

List elements can be customized as you like. This allows you to select hidden projects
and tasks (when show hidden tasks mode is on), mark projects that contain unpaid
time periods, etc.
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1. Choose configuration. You can edit configurations via clicking the Customize item
appearance  button.
2. Current settings example.
3. Click this to edit appearance settings.

3.7.8 Element appearance

This dialog box allows you to edit configurations used to mark lines in project, task
and period lists. In mark settings  you can specify which configuration to use in
each case.

61
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1. List of existing configurations.
2. Example of using current configuration.
3. Use different line background.
4. Choose background color.
5. Use different font color.
6. Choose font color.
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1. Show line mark. A mark is a small triangle in the lower right corner of a line.
2. Choose mark color.
3. Use different font style.
4. Use bold style.
5. Use italic style.
6. Use underlined style.
7. Use strikethrough style.

3.7.9 Computer assistance

AllNetic Working Time Tracker utilizes automatic algorithms to help user remember
when he/she needs to start or stop time tracking. However, the application will never
do it by itself. Only the user decides what he/she does at the moment.

You can customize automatic hits to your needs or disable them if you want.

Select Computer assistance tab in the application options.
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1. Check this to turn automatic start intelligence on
2. User inactivity waiting time
3. Maximum activity time considered as no activity
4. Activity detection period
5. Minimum activity time considered as start of activity
6. Check this to turn automatic stop intelligence on
7. User inactivity waiting time
8. Maximum activity time considered as no activity
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1. Disable mouse activity check
2. Check this to abandon too short periods (e. g. added by mistake)
3. Minimum period length to keep the period in records.

To understand each option in detail, let us go through the assistance algorithm.

You do not want computer to bore you with reminders, so the application waits until
the user leaves the computer (Choose waiting time in option 2, 180 seconds
recommended). To detect this situation reliably, the application tolerates some
random events, e. g. you may push you table accidentally and move the mouse a bit.
(Choose time in option 3. 5 to 10% of option 2 time is recommended). In other
words, the application starts inactivity waiting time counter right after your last
keystroke or mouse move before you leave. If during this time the casual activity is
not more than 5 to 10%, the application will consider it as real inactivity.

Now the application will track when the user resumes his/her work. Some tolerance of
casual events is needed too. The application waits specified time (choose option 4, 60
seconds recommended). If during this time some significant activity (during time set
in option 5, 50% of option 4 recommended), the application proposes to start time
tracking. You just need to select what you are working on. In other words, the
application starts activity waiting time counter as soon as the time tracking is
stopped, and if you activity during this time is more than 50%, the application
proposes to start time tracking.

Automatic tracking stop algorithm works in the same way. The application is
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continuously tracking the user activity. If during the specified time (choose time in
option 7, 180 seconds recommended) the user was not active enough (choose time in
option 8, 5 to 10% of option 7 time is recommended), the application will propose to
stop time tracking.

Our experience shows that some models of mice may flicker even if nobody touches
them. Sometimes this happens because of low-quality daylight lamps that shimmer
on the mains frequency. If this is the case, you can disable mouse tracking at all.

Also you can use short period deletion feature that is handy to harness casual
tracking starts. AllNetic Working Time Tracker will delete all short accidental periods
automatically.

3.7.10 Tray hint and icon

1. Display advanced tray hint  when you roll mouse over the tray icon.
2. Display time spent for all projects in the advanced hint.
3. Display time spent for selected projects in the advanced hint.
4. Display time spent for selected tasks in the advanced hint.
5. If this option is on, display time of selected projects and tasks. Otherwise, display
time of active project and task.
6. If this option is on, the tray icon will be always displayed. Otherwise the icon will
be displayed only if the application is minimized.

49
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7. Select action on left-click on the tray icon.
8. Select action on Shift + left-click on the tray icon.
9. Select action on double-click on the tray icon.

3.8 Import wizard

3.8.1 Import wizard

1. Data import from CSV format
2. Data import from internal format.
3. Data import from other formats.

Import from other formats is currently not supported.
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3.8.2 Import from CSV file

1. Full path to the imported file
2. Display explorer to select a file

Choose the imported file and move to the next step by clicking the Next button.
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1. Several first lines of the imported file.
2. Field settings.
3. Edit field number
4. Edit field format

A CSV file consists of several lines containing data separated by "," or ";". You have
to define which field means what.

· Project/Task name
Choose field number containing project and task names

· Project/Task UID
Choose field number containing unique identifiers of projects and tasks. A

unique identifier should be 32-bit integer.

· Project/Task description
Choose field number containing period and task descriptions.

· Owner name
Choose field number containing parent task (to retain hierarchy).

· Owner UID
Choose field number containing UID of parent task (to retain hierarchy of

projects and tasks). Specifying Owner name or Owner UID is enough.

· Begin date
Choose field number containing period start date. A field with start time

should be defined.
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· Begin time
Choose field number containing period start time (no date).

· Begin date and time
Choose field number containing period start date and time. Begin date and

Begin time fields should not be defined.

· End date
Choose field number containing period end date. A field with end time should

be defined.

· End time
Choose field number containing period end time (no date).

· End date and time
Choose field number containing period end date and time. End date and End

time fields should not be defined.

· Period duration
Choose field number containing period duration. Fields describing period end

time should not me defined.

· Period description
Choose field number containing period description.

Data import is possible only if period start is defined and period end is computable.
Thus, the following fields should be defined:
· Begin date and Begin time, or Begin date and time
· End date and time, End date and End time, or Period duration

Data will be inserted to the current (selected) task.
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1. Data import log.
All information and error messages will be displayed in this window. Click

Finish to confirm data import.
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3.9 Report wizard

3.9.1 Report wizard

1. In the drop-down list, choose preset report settings.
2. Delete selected settings.
3. Click this to edit selected settings.

To save typical settings for future reports, you can save settings after entering data in
the wizard. After the first time you use reports, the list will contain the only
"Custom..." settings.

Choose "Custom..." to re-enter all settings.
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1. Choose source data:
2. Data from all projects
3. Data from selected projects only
4. Data from selected tasks only
5. Data from selected periods only
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1. Time interval selection. The report will contain data from this period only.
2. Interval start.

Check the option on and set the time. Otherwise the application
installation time will be set.

3. Click this to insert current time, or click the down arrow to select from
several options.

4. Interval end.
Check the option on and set the time.

5. Click this to insert current time, or click the down arrow to select from
several options.
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1. If this option is on, all periods in the report will be marked as paid.
2. If this option is on, unpaid period will be excluded from the report.
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1. Full path to a template.
Choose a report template from the drop-down list. The list contains all

templates from the default template folder. You can also store your templates in any
other place.
2. Use explorer to choose a template.
3. Click this to edit selected template.
4. Template settings.
5. Refresh template. Click this if you have edited the template.

1. Include only general statistics
2. Include statistics and projects
3. Include statistics, projects and tasks
4. Full-detail report including periods
5. Use data from tasks marked as Track only (normally not included into reports)
6. If this option is on, all hidden tasks will be ignored
7. If this option is on, projects and tasks with zero length are not included to the
report. This option is also handy to build reports for specific time intervals. In this
case a report will include only projects and tasks you were working on during the
interval.
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1. Full path and filename of the destination report file
2. Use explorer to choose destination path and filename
3. If this option is on, the report will be saved in unicode format
4. If this option is on, the report will be displayed for viewing automatically after
creation
5. Check this option on to save wizard settings, e. g. report detail level, time interval,
template, etc
6. New settings name

Click Finish to create the report.
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